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1. Overview

The J∆S Engineering Suite provides a complete plumbing engineering design toolkit spanning eleven dedicated modules.

Together these modules cover every calculation a plumbing engineer performs on a commercial or institutional project:

fixture counts, water supply sizing, sanitary drainage, vent design, hot water systems, gas piping, storm drainage, backflow

prevention, grease interceptors, waste pipe inversions, and water pressure analysis.

All calculations are performed in IP (Imperial) units -- GPM, feet, inches, PSI, MBH -- and comply with the International

Plumbing Code (IPC) 2021, Uniform Plumbing Code (UPC) 2022, California Plumbing Code (CPC) 2022, and the
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International Fuel Gas Code (IFGC) 2021.

1.1 Scope
This guide walks through a complete plumbing design for a 100,000 SF, 4-story office building (25,000 SF per floor)

located in San Diego, California. The same project is referenced in the companion HVAC guides so that mechanical

engineers can see how plumbing and HVAC systems interact within a single project file.

1.2 Applicable Codes and Standards

Code / Standard Edition Application

International Plumbing Code (IPC) 2021 Fixture counts, pipe sizing, drainage, venting

Uniform Plumbing Code (UPC) 2022 Fixture counts, pipe sizing, drainage, venting

California Plumbing Code (CPC) 2022 State amendments to UPC (California
projects)

California Building Code (CBC) 2022 Occupancy classification, occupant load

International Fuel Gas Code (IFGC) 2021 Natural gas piping (non-California)

NFPA 54 2021 National Fuel Gas Code

ASME A112 series Current Plumbing fixture standards

ASSE 1000 series Current Backflow prevention, safety devices

ASHRAE 90.1 2022 Pipe insulation requirements

ASHRAE HVAC Applications Ch. 51 Service water heating design

SMACNA Current Seismic bracing for piping

PDI G101 Current Grease interceptor sizing

ASCE 7-22 Current Rainfall intensity maps

1.3 Design Philosophy
The J∆S Engineering Suite follows the standard professional workflow:

1. Determine occupant load from building area and occupancy type.

2. Calculate minimum fixture counts per code.

3. Assign Water Supply Fixture Units (WSFU) and Drainage Fixture Units (DFU).

4. Convert WSFU to flow rate (GPM) using Hunter's Curve.

5. Size supply piping based on velocity limits and available pressure.

6. Size drainage piping based on DFU capacity tables.

7. Size vents per code tables and developed length.

8. Design hot water system with storage, recovery, and recirculation.

9. Design storm drainage from rainfall intensity and roof area.
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10. Size natural gas piping from total appliance demand.

11. Verify backflow prevention, grease interception, and waste pipe inversions.

All calculations are performed in IP (Imperial) units: GPM, feet, inches, PSI, MBH.

2. Plumbing Module Map

The J∆S Engineering Suite contains the following plumbing-related modules, accessible from the left sidebar under the

PLUMBING TOOLS category and related sections.

2.1 Primary Plumbing Modules

Module Name Source File Sidebar Location Description

Fixture Calculator plumbing_calcs_app.py Plumbing Tools WSFU/DFU per IPC/UPC,
Hunter's curve, drain sizing, gas
piping, storm drainage, water
pressure -- all in 8 tabs

Water Pressure Calc water_pressure_app.py Plumbing Tools IPC Chapter 6 / UPC domestic
water pressure analysis and pipe
sizing

Gas Pipe Sizer gas_pipe_app.py Plumbing Tools IFGC/NFPA 54 gas pipe sizing
with Spitzglass/Weymouth
formulas

Hot Water Sizing hot_water_app.py Plumbing Tools ASHRAE storage + recovery
method with manufacturer
equipment data

Domestic Hot Water domestic_hot_water_app.p
y

Plumbing Tools ASHRAE Ch.51, UPC/IPC fixture
unit method, recirculation design,
ASSE 1017

Storm Drainage storm_drainage_app.py Plumbing IPC/UPC Chapter 11 storm
drainage design with Manning's
equation

Waste Pipe Invert waste_invert_app.py Plumbing Tools Invert elevation calculations for
gravity drainage

2.2 Supporting Modules

Module Name Source File Sidebar Location Description

Pipe Sizer pipe_sizer_app.py Core Calculations Hazen-Williams and
Darcy-Weisbach pipe sizing for
all fluid systems

Pipe Network pipe_network_app.py Specialty Engineering Hydronic pipe network analysis
with Darcy-Weisbach, ASHRAE
Ch. 22
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Module Name Source File Sidebar Location Description

Grease Interceptor grease_interceptor_app.p
y

Plant / System Tools PDI G101, UPC, IPC sizing
methods with manufacturer data

IPC/CPC Plumbing Code Reference module References & Standards Plumbing code lookup and
cross-reference tool

2.3 Launching Any Plumbing Module
1. Open the J∆S Engineering Suite: run python launcher.py.

2. Log in and navigate to the Dashboard.

3. In the left sidebar, expand the appropriate category (usually Plumbing Tools or Plumbing).

4. Click the module name.

5. The module opens in a new window with tabbed sub-panels.

6. Load an existing project (.mep file) or create a new one. Building geometry and occupancy data carry over from the

HVAC model automatically when using a shared project file.

3. Fixture Unit Method

3.1 Theory and Background
The fixture unit method is the universal approach for sizing plumbing systems in commercial buildings. It was originally

developed by Dr. Roy B. Hunter at the National Bureau of Standards in the 1940s and is codified in IPC Chapter 6, UPC

Chapter 6, and CPC Chapter 6.

The method assigns numerical values -- Water Supply Fixture Units (WSFU) for supply sizing and Drainage Fixture Units

(DFU) for drain sizing -- to each plumbing fixture. These values represent the probable hydraulic demand considering the

intermittent nature of fixture use. The fixture unit totals are then converted to flow rates using probability-based curves

(Hunter's Curve).

3.2 Occupant Load Calculation
The minimum number of plumbing fixtures is driven by the building occupant load. For an office (Business occupancy,

Group B per IBC/CBC), the occupant load factor is 100 SF per occupant (gross area).

Floor Area (SF) Occupant Load Factor Occupants

1 25,000 100 SF/person 250

2 25,000 100 SF/person 250

3 25,000 100 SF/person 250

4 25,000 100 SF/person 250

Total 100,000 1,000
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3.3 Minimum Fixture Counts per Code
For Business (Group B) occupancy, IPC Table 403.1 / CBC Table 422.1 requires the following minimum fixtures.

Assuming a 50/50 male-to-female ratio (500 males, 500 females building-wide; 125 of each per floor):

Per-Floor Fixture Requirements (25,000 SF, 250 occupants):

Fixture Type Male Female Total/Floor Basis

Water Closets (WC) 2 4 6 1 per 25 male, 1 per 15
female

Urinals 4 -- 4 May substitute for up to
67% of male WC;
provided as supplemental

Lavatories 3 3 6 1 per 40 occupants

Kitchen/Break Room
Sinks

1 1 2 1 per 100 occupants
(service)

Drinking Fountains 1 -- 1 1 per 100 occupants (hi-lo
pair counts as 1)

Service Sinks 1 -- 1 1 per floor minimum
(janitor)

Floor Total 20

Building Total (4 Floors):

Fixture Type Per Floor x 4 Floors Building Total

Water Closets 6 x 4 24

Urinals 4 x 4 16

Lavatories 6 x 4 24

Sinks 2 x 4 8

Drinking Fountains 1 x 4 4

Service Sinks 1 x 4 4

Grand Total 20 80

3.4 WSFU Table -- IPC Table 604.3
Water Supply Fixture Units quantify the probable simultaneous demand from each fixture type. The J∆S Engineering Suite

contains the complete IPC Table 604.3 data set, reproduced here for reference:

Fixture WSFU (Cold) WSFU (Hot) WSFU (Total)

Water Closet (Tank) 2.5 0.0 2.5

Water Closet (Flushometer) 5.0 0.0 5.0

Urinal (Flushometer) 5.0 0.0 5.0
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Fixture WSFU (Cold) WSFU (Hot) WSFU (Total)

Urinal (Tank) 3.0 0.0 3.0

Lavatory (Public) 1.5 1.5 2.0

Lavatory (Private) 0.5 0.5 1.0

Bathtub (w/ Shower) 1.0 1.0 1.5

Shower (Public) 3.0 3.0 4.0

Shower (Private) 1.0 1.0 1.5

Kitchen Sink (Residential) 1.0 1.0 1.5

Kitchen Sink (Commercial) 3.0 3.0 4.0

Service Sink 1.5 1.5 3.0

Mop Sink 1.5 1.5 3.0

Drinking Fountain 0.5 0.0 0.5

Hose Bibb 2.5 0.0 2.5

Dishwasher (Residential) 0.0 1.4 1.4

Dishwasher (Commercial) 0.0 5.0 5.0

Clothes Washer (Residential) 1.0 1.0 1.5

Clothes Washer (Commercial) 3.0 3.0 4.0

Floor Drain 0.0 0.0 0.0

Emergency Shower 5.0 0.0 5.0

Emergency Eyewash 2.5 0.0 2.5

Water Cooler 0.5 0.0 0.5

Lab Sink 1.0 1.0 2.0

UPC Table 610.3 (Alternate Values):

The UPC assigns slightly different values for some fixtures, notably higher values for flush-valve water closets (10 WSFU)

and flush-valve urinals (5 WSFU). The J∆S Engineering Suite allows the user to select IPC or UPC as the governing code,

and the WSFU table updates accordingly.

Fixture UPC WSFU (Total) IPC WSFU (Total) Difference

Water Closet (Flush Valve) 10 5 UPC is more conservative

Urinal (Flush Valve) 5 5 Same

Lavatory (Public) 2 2 Same

Kitchen Sink (Commercial) 4 4 Same

3.5 DFU Table -- IPC Table 709.1
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Drainage Fixture Units quantify the probable discharge from each fixture and determine drain pipe sizing. The complete

table as implemented in the software:

Fixture DFU Trap Size (in)

Water Closet (Tank) 3.0 3.0

Water Closet (Flushometer) 4.0 3.0

Urinal (Flushometer) 4.0 2.0

Urinal (Tank) 2.0 2.0

Lavatory (Public) 1.0 1.25

Lavatory (Private) 1.0 1.25

Bathtub (w/ Shower) 2.0 1.5

Shower (Public) 2.0 2.0

Shower (Private) 2.0 2.0

Kitchen Sink (Residential) 2.0 1.5

Kitchen Sink (Commercial) 3.0 2.0

Service Sink 3.0 2.0

Mop Sink 3.0 3.0

Drinking Fountain 0.5 1.25

Dishwasher (Residential) 2.0 1.5

Dishwasher (Commercial) 4.0 2.0

Clothes Washer (Residential) 2.0 2.0

Clothes Washer (Commercial) 3.0 2.0

Floor Drain 2.0 2.0

Emergency Shower 2.0 2.0

Emergency Eyewash 1.0 1.25

Water Cooler 0.5 1.25

Lab Sink 2.0 1.5

3.6 Entering Fixtures in the Fixture Calculator
In the Fixtures tab of the Fixture Calculator module, the software pre-populates fixture counts when you select an

occupancy type and enter the floor area. You can override any value to match the architect's fixture schedule. Each fixture

row includes:

• Fixture Type -- Drop-down menu containing all fixture types listed in the WSFU and DFU tables above

• Quantity -- Integer spinner for the number of fixtures

• Flush/Flow Type -- Selection between flush valve and flush tank (for water closets and urinals)
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• WSFU Cold -- Auto-filled per the selected code table

• WSFU Hot -- Auto-filled per the selected code table

• WSFU Total -- Auto-filled per the selected code table

• DFU -- Auto-filled per the selected code table

• Trap Size (in) -- Auto-filled per the selected code table

• Hot Water Demand (GPM) -- For DHW calculations

The software flags any floor where the fixture count falls below code minimums with a red warning banner.

3.7 Floor-by-Floor WSFU Calculation -- Worked Example
Floor 1 (typical of all floors, using IPC values with flushometer WC/urinals):

Fixture Qty WSFU Each Floor WSFU

Water Closets (flushometer) 6 5.0 30.0

Urinals (flushometer) 4 5.0 20.0

Lavatories (public) 6 2.0 12.0

Kitchen/Break Sinks
(commercial)

2 4.0 8.0

Drinking Fountain 1 0.5 0.5

Service Sink 1 3.0 3.0

Floor 1 Total 20 73.5

Since all four floors are identical:

Level WSFU

Floor 1 73.5

Floor 2 73.5

Floor 3 73.5

Floor 4 73.5

Building Total 294.0

3.8 Floor-by-Floor DFU Calculation -- Worked Example
Floor 1 (typical):

Fixture Qty DFU Each Floor DFU

Water Closets (flushometer) 6 4.0 24.0

Urinals (flushometer) 4 4.0 16.0
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Fixture Qty DFU Each Floor DFU

Lavatories 6 1.0 6.0

Sinks (commercial) 2 3.0 6.0

Drinking Fountain 1 0.5 0.5

Service Sink 1 3.0 3.0

Floor 1 Total 20 55.5

Building Summary:

Level DFU

Floor 1 55.5

Floor 2 55.5

Floor 3 55.5

Floor 4 55.5

Building Total 222.0

4. Water Supply Pipe Sizing

4.1 Hunter's Curve Conversion: WSFU to GPM
Hunter's Curve (IPC Table E103.3(2) / UPC Appendix A) converts the total WSFU to a peak probable demand in GPM.

The curve accounts for the statistical improbability that all fixtures operate simultaneously.

The J∆S Engineering Suite contains the following Hunter's Curve data points (embedded in plumbing_calcs_app.py):

WSFU GPM WSFU GPM

0 0.0 300 52.0

1 1.0 400 60.0

2 3.0 500 67.0

5 5.0 600 73.0

8 6.5 700 79.0

10 8.0 800 84.0

15 10.0 900 89.0

20 12.0 1,000 94.0

25 14.0 1,200 103.0

30 15.5 1,500 115.0
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WSFU GPM WSFU GPM

40 18.0 2,000 133.0

50 20.5 2,500 149.0

60 22.5 3,000 163.0

80 27.0 4,000 189.0

100 30.0 5,000 212.0

120 33.0 6,000 233.0

140 35.5 8,000 270.0

160 38.0 10,000 304.0

180 40.0

200 42.0

250 47.5

Worked Example:

• Floor 1: 73.5 WSFU -- interpolating between 60 (22.5 GPM) and 80 (27.0 GPM):

• 22.5 + (73.5 - 60)/(80 - 60) x (27.0 - 22.5) = 22.5 + 3.04 = ~25.5 GPM per floor

• Building Total: 294 WSFU -- interpolating between 250 (47.5 GPM) and 300 (52.0 GPM):

• 47.5 + (294 - 250)/(300 - 250) x (52.0 - 47.5) = 47.5 + 3.96 = ~51.5 GPM

• Apply diversity factor for 4-story riser: use ~55 GPM design flow

The J∆S Engineering Suite performs this interpolation automatically and displays the result in the Water Supply tab under

"Peak Demand (GPM)."

4.2 Hazen-Williams Equation
For water supply pipe sizing, the software uses the Hazen-Williams equation for friction loss, which is the standard method

in the plumbing industry:

h_f = (4.52 x Q^1.85) / (C^1.85 x d^4.87)

Where:
h_f = friction head loss (ft per ft of pipe)
Q = flow rate (GPM)
C = Hazen-Williams C-factor (pipe material roughness)
d = internal pipe diameter (inches)

Hazen-Williams C-Factors (from pipe_sizer_app.py):

Pipe Material C-Factor

Copper (new) 140-150

Type L Copper 150

Type K Copper 150
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Pipe Material C-Factor

CPVC (SDR 11) 150

PEX 150

Galvanized Steel (new) 120

Steel (new) 130

Steel (10-year) 110

Steel (20-year) 90

Stainless Steel 140-150

Ductile Iron 130-140

Cast Iron 100

PVC 150

HDPE 150

4.3 Velocity Limits
Pipe sizing is governed by two constraints:

1. Maximum velocity: 8 fps for copper and plastic supply piping (ASME B31.9 / UPC/IPC recommendation to limit

water hammer and erosion). For steel pipe, 10 fps is sometimes acceptable.

2. Pressure drop: Total friction loss + static head + fixture residual pressure must not exceed available street

pressure.

Velocity-based sizing formula:

Q = A x V
GPM = (pi/4 x D^2 / 144) x V x 7.48 x 60

Where:
Q = flow rate (GPM)
D = internal pipe diameter (inches)
V = velocity (fps)

Pipe capacity at 8 fps (Type L Copper):

Nominal Size ID (in) Capacity at 8 fps (GPM) Max WSFU (Flush Valve) Max WSFU (Flush Tank)

3/8" 0.430 3.6 1 1

1/2" 0.545 5.8 3 5

3/4" 0.785 12.1 8 15

1" 1.025 20.7 20 40

1-1/4" 1.265 31.5 40 85

1-1/2" 1.505 44.6 70 150

2" 1.985 77.6 150 350
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Nominal Size ID (in) Capacity at 8 fps (GPM) Max WSFU (Flush Valve) Max WSFU (Flush Tank)

2-1/2" 2.465 119.6 280 600

3" 2.945 170.8 500 1,000

4" 3.905 300.2 1,000 2,000

5" 4.875 468.0 1,800 3,600

6" 5.845 672.6 2,800 5,600

4.4 Minimum Pressure at Fixtures
IPC Table 604.3 and the Water Pressure Calculator module enforce minimum residual pressures:

Fixture Type Minimum Pressure (psi)

Flush valve (WC or urinal) 15

Flush tank (WC or urinal) 8

All other fixtures (lavatory, sink, shower, etc.) 8

Drinking fountain 8

Bathtub 8

Emergency shower 8

Ice maker 8

Lab sink 8

Dental chair 8

4.5 Sizing Results for the Example Project
• Building main (55 GPM, 294 WSFU): 2" copper provides capacity for 150 WSFU (flush valve) -- sufficient. Select

2" Type L copper for the building main.

• Floor risers (~25.5 GPM per floor, 73.5 WSFU): 1-1/2" copper provides capacity for 70 WSFU -- adequate. Select

1-1/2" Type L copper for risers.

• Branch lines to restroom groups (~15 GPM): 1-1/4" copper (31.5 GPM capacity).

• Individual fixture connections: 1/2" to 3/4" per fixture manufacturer requirements.

4.6 Pipe Materials Supported
The Water Pressure Calculator and Pipe Sizer modules support the following pipe materials:

Material C-Factor Available Sizes

Type L Copper 150 1/2" through 6"

Type K Copper 150 1/2" through 6"
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Material C-Factor Available Sizes

CPVC (SDR 11) 150 1/2" through 4"

PEX 150 3/8" through 2"

Galvanized Steel 120 1/2" through 6"

Ductile Iron 140 2" through 12"

Stainless Steel 150 1/2" through 4"

5. Drainage Pipe Sizing

5.1 Drainage Capacity Tables
The Fixture Calculator module sizes drainage piping based on DFU capacity tables per IPC Table 710.1 / UPC Table

702.1. Horizontal drain sizing considers both the total DFU load and the pipe slope:

Pipe Size (in) Max DFU at 1/8"/ft Slope Max DFU at 1/4"/ft Slope

1-1/4" 0 1

1-1/2" 1 1

2" 8 10

3" 35 42

4" 216 250

5" 428 500

6" 720 840

8" 1,920 2,240

10" 3,500 4,200

12" 5,600 6,700

Drain pipe inside diameters (for Manning's calculations):

Nominal Size ID (in)

1-1/4" 1.38

1-1/2" 1.61

2" 2.07

3" 3.07

4" 4.03

5" 5.05
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Nominal Size ID (in)

6" 6.07

8" 7.98

10" 10.02

12" 11.94

5.2 Horizontal vs. Vertical Drain Sizing
Horizontal drains (building drains, branch drains) are sized from the tables above, using the DFU count and the desired

slope. Steeper slopes carry more DFU because water velocity is higher.

Vertical stacks (soil and waste stacks) have different capacities than horizontal drains. Per IPC Table 710.1(1):

Stack Size Max DFU Total (3+ stories) Max DFU per Branch Interval

2" 16 6

3" 48 20

4" 240 90

5" 540 200

6" 960 350

8" 2,200 600

10" 3,800 1,000

12" 5,600 1,500

5.3 Building Drain Sizing -- Worked Example
For this project (222 DFU):

• At 1/8"/ft slope: 4" pipe handles 216 DFU (insufficient by 6 DFU). Select 5" building drain (428 DFU capacity).

• At 1/4"/ft slope: 4" pipe handles 250 DFU (adequate with 28 DFU margin). A 4" building drain at 1/4"/ft slope is

acceptable.

The J∆S Engineering Suite defaults to 1/8"/ft slope (conservative) and selects the next size up when the DFU count is

within 10% of the pipe capacity limit. For this project, the software recommends: 4" building drain at 1/4"/ft slope or 5"
building drain at 1/8"/ft slope.

5.4 Sanitary Stack Sizing -- Worked Example
Each restroom group connects to a vertical soil/waste stack:

• Per-floor branch: 55.5 DFU -- 3" is insufficient (max 20 per branch interval). Select 4" stacks (90 DFU per branch,

240 total).

• Total on one stack (if all 4 floors connect): 222 DFU. A single 4" stack handles 240 DFU -- adequate.
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• Typical design: provide two 4" stacks (one for each restroom core) for redundancy and to keep branch distances

manageable.

5.5 Building Sewer Sizing
The building sewer (pipe from the building to the municipal sewer main) is typically one size larger than the building drain

to account for roots, settlement, and future growth:

Building Drain Size Recommended Building Sewer Size

4" 5" or 6"

5" 6"

6" 6" or 8"

8" 8" or 10"

For this project with a 4" or 5" building drain, the building sewer should be 6" minimum.

5.6 Manning's Equation for Drainage Flow
The software also uses Manning's equation to verify gravity drainage capacity:

Q = (1.486 / n) x A x R^(2/3) x S^(1/2)

Where:
Q = flow rate (CFS)
n = Manning's roughness coefficient
A = cross-sectional flow area (ft^2)
R = hydraulic radius = A/P (ft)
S = slope (ft/ft)

Manning's n values:

Pipe Material Manning's n

PVC / ABS 0.009

Cast Iron (coated) 0.012

Cast Iron (uncoated) 0.013

Concrete 0.013

Clay (vitrified) 0.013

Ductile Iron 0.012

Copper DWV 0.011

Steel 0.015

6. Vent Sizing
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6.1 Purpose of Venting
Every trap in a plumbing system must be vented to:

• Prevent siphonage (loss of trap seal when water flows past)

• Prevent back-pressure (positive pressure pushing sewer gas through the trap)

• Allow air to enter the drainage system so water flows freely by gravity

6.2 Types of Vents

Vent Type Description Typical Application

Individual vent Single vent serving one fixture trap Isolated fixtures

Common vent Single vent serving two fixture traps at same
level

Back-to-back fixtures

Branch vent Vent connecting two or more individual vents Groups of fixtures on same floor

Vent stack Vertical vent extending through one or more
stories

Multi-story buildings

Stack vent Upper portion of a soil/waste stack above
highest branch

Extension of stack through roof

Circuit vent Single vent serving a group of fixtures on a
horizontal branch

Battery of fixtures (restrooms)

Island vent (loop vent) Special venting arrangement for island sinks Kitchen islands

Air admittance valve (AAV) Mechanical one-way valve allowing air in but
not out

Where conventional venting is impractical

Combination waste and vent Single pipe serving as both drain and vent Limited applications per code

6.3 Vent Sizing Tables -- IPC Table 916.1 / UPC Table 703.2
Vent sizing depends on the connected DFU and the developed length (total length of the vent pipe from the trap to the vent

termination):

Vent Size (in) Max DFU (developed length <
40 ft)

Max DFU (developed length <
60 ft)

Max DFU (developed length <
100 ft)

1-1/4" 8 6 4

1-1/2" 24 18 12

2" 48 36 24

2-1/2" 96 72 48

3" 240 180 120

4" 500 390 256

5" 1,100 850 540

6" 1,900 1,500 960
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6.4 Vent Sizing -- Worked Example
For the example project:

• Individual fixture vents: 1-1/2" for lavatories and sinks (1-3 DFU each); 2" for WC and urinal groups (4 DFU each)

• Branch vents (per restroom group): 55.5 DFU per floor on a branch vent with developed length < 60 ft -- 2-1/2"

vent (72 DFU capacity)

• Vent stack (combined all floors): 222 DFU total on a 4-story vent stack with developed length ~60 ft -- 3" vent

stack (180 DFU max at 60 ft) is marginal. Select 4" vent stack (390 DFU capacity at 60 ft)

• Vent termination: Through the roof per IPC Section 903.1 / UPC Section 906, minimum 6" above roof surface and

10 feet from any air intake, operable window, or door

6.5 Circuit Venting
For battery installations (multiple fixtures in a row, such as a bank of water closets), circuit venting is an efficient alternative

to individual venting:

• Per IPC Section 911: A circuit vent may serve up to 8 fixtures on a horizontal branch.

• The circuit vent connects downstream of the last fixture and upstream of the first fixture on the branch.

• The circuit vent pipe must be at least half the diameter of the horizontal branch, but not less than 1-1/2".

• A relief vent is required at the upstream end of the horizontal branch if it serves more than 4 water closets.

6.6 Vent Pipe Sizing Rules of Thumb
1. A vent pipe must be at least half the diameter of the drain it serves, but never less than 1-1/4".

2. A vent stack must be at least as large as the required individual vent for the highest connected branch.

3. The total developed length of vent piping affects the required diameter -- longer runs need larger vents.

4. Wet vents (pipes serving as both drain and vent) have specific sizing requirements per IPC Section 912.

7. Hot Water System Design

7.1 Overview
The J∆S Engineering Suite includes two dedicated hot water modules plus a DHW tab within the Plumbing Calculator:

Module Focus Key Methods

Hot Water Sizing (hot_water_app.py) ASHRAE storage + recovery, manufacturer
equipment selection, energy comparison

7 building type profiles, 5+ manufacturer
databases

Domestic Hot Water
(domestic_hot_water_app.py)

System design, pipe sizing, recirculation,
ASSE 1017 mixing valves, Legionella
compliance

ASHRAE 188, equipment selection,
compliance export
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Module Focus Key Methods

Plumbing Calculator DHW tab Quick DHW demand within the main plumbing
module

Fixture-based demand only

7.2 Hot Water Demand by Fixture Type
The software contains fixture hot water demands per ASHRAE HVAC Applications Chapter 51:

Fixture Flow (GPM) Peak (GPH) Daily (gal) Temp (deg F) UPC FU

Lavatory (Public) 0.5 2.0 2.0 105 1.5

Lavatory (Private) 0.5 2.0 4.0 105 0.5

Shower (Public) 2.0 30.0 20.0 110 3.0

Shower (Private) 2.0 20.0 20.0 110 1.0

Kitchen Sink
(Residential)

1.5 10.0 10.0 120 1.0

Kitchen Sink
(Commercial)

1.5 20.0 15.0 140 3.0

Bathtub 4.0 20.0 20.0 105 1.0

Dishwasher
(Residential)

1.0 15.0 10.0 140 1.4

Dishwasher
(Commercial)

2.5 50.0 150.0 180 5.0

Clothes Washer 2.0 20.0 25.0 120 1.5

Service Sink 1.5 15.0 10.0 140 3.0

Mop Sink 1.5 20.0 15.0 140 3.0

Prep Sink 1.5 15.0 12.0 120 2.0

Bar Sink 1.0 10.0 8.0 120 1.0

Whirlpool Tub 4.0 40.0 40.0 105 4.0

7.3 Building Type Demand Profiles (ASHRAE Ch. 51)
The Hot Water Sizing module provides pre-configured demand profiles for seven building types:

Building Type Unit GPD/Unit Peak Hour Fraction Storage Factor Recovery Fraction

Office persons 1.0 0.30 0.20 0.70

Hotel/Motel rooms 30.0 0.35 0.60 0.70

Restaurant meals 2.5 0.40 0.40 0.60

Hospital beds 60.0 0.25 0.60 0.80

School students 1.5 0.40 0.30 0.70
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Building Type Unit GPD/Unit Peak Hour Fraction Storage Factor Recovery Fraction

Gym/Fitness persons 10.0 0.50 0.50 0.70

Residential units 40.0 0.30 0.40 0.70

Each profile includes a 24-hour demand curve (hourly fractions) for detailed analysis.

7.4 ASHRAE Storage + Recovery Method
The ASHRAE method sizes the hot water system based on two components:

1. Storage volume -- Hot water stored in a tank to meet peak demand bursts.

2. Recovery rate -- The rate at which the water heater can reheat incoming cold water.

Storage Volume = Peak Hour Demand x Storage Factor
Recovery Rate = Peak Hour Demand x Recovery Fraction
Heater Output = Recovery Rate x 500 x Delta_T

Where:
500 = 8.33 lb/gal x 60 min/hr x 1 BTU/(lb-deg F)
Delta_T = Storage temp - Inlet temp (deg F)

7.5 Hot Water Demand Analysis -- Worked Example
For the 100,000 SF office (1,000 occupants):

Parameter Value

Daily demand (1.0 GPD/person x 1,000) 1,000 gal/day

Peak hour demand (1,000 x 0.30) 300 gal/hr

Storage volume (300 x 0.20) 60 gallons (min)

Recovery rate (300 x 0.70) 210 gal/hr

Temperature rise (140 - 60 deg F for San Diego winter) 80 deg F

Heater output (210/60 x 500 x 80) 140,000 BTU/hr = 140 MBH

Select a 100-gallon storage tank (provides safety margin) with a 150 MBH water heater. Manufacturer options include:

• A.O. Smith BTH-150 (150 MBH, 95% efficiency)

• Bradford White eF120T-150 (150 MBH, 96% efficiency)

• Rheem GHE150-150N (150 MBH, 95% efficiency)

• Lochinvar AWN151 (155 MBH, 96% efficiency)

7.6 Recirculation System Design
A domestic hot water recirculation loop is required per IPC Section 607.2.1 / CPC Section 609.11 for buildings where the

hot water source is more than 50 feet developed length from the farthest fixture.

Recirculation system sizing procedure:
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1. Calculate total loop length (supply + return).

2. Estimate heat loss from piping at 15-30 BTU/hr per linear foot (insulated pipe).

3. Calculate required recirculation flow to offset heat losses:

Q_recirc = Total Heat Loss / (500 x Delta_T_loop)

Where:
Delta_T_loop = Temperature drop allowed in loop (typically 5-10 deg F)

For this project:

• Loop length: approximately 400 feet (supply + return through 4 floors)

• Design temperature drop in loop: 10 deg F (140 deg F supply, 130 deg F return)

• Heat loss from piping: estimated 15 BTU/hr per linear foot (insulated)

• Total heat loss: 400 ft x 15 BTU/hr/ft = 6,000 BTU/hr

• Required recirculation flow: 6,000 / (500 x 10) = 1.2 GPM

• Design flow with safety margin: 5 GPM

• Estimated head loss: 15 ft (friction through 400 ft of 3/4" copper + fittings)

Selected: Bronze-fitted inline circulator, 5 GPM at 15 ft head, 1/12 HP, with timer and aquastat for night/weekend setback.

7.7 Mixing Valves -- ASSE 1017
Central mixing valves (thermostatic mixing valves) temper stored hot water (typically 140 deg F for Legionella control)

down to a safe delivery temperature (typically 120 deg F or less):

Application Maximum Delivery Temperature Standard

Public lavatories 110 deg F ASSE 1070

Showers 120 deg F ASSE 1016

Kitchen sinks 120 deg F ASSE 1017

Service sinks 140 deg F Direct from heater

Commercial dishwasher 180 deg F Direct from booster heater

The Domestic Hot Water module sizes mixing valves based on the mixed flow rate and the hot/cold supply temperatures

using the mixing valve equation:

T_mixed = (Q_hot x T_hot + Q_cold x T_cold) / (Q_hot + Q_cold)

7.8 Pipe Insulation Requirements
Per ASHRAE 90.1-2022 Table 6.8.3-1 and IPC/CPC requirements, all DHW piping must be insulated:

Pipe Size Insulation Thickness (Fiberglass) R-value

3/4" and smaller 1/2" R-2.6

1" to 1-1/2" 1" R-4.2
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Pipe Size Insulation Thickness (Fiberglass) R-value

2" to 4" 1-1/2" R-5.5

Over 4" 2" R-7.4

Recirculation return piping requires the same insulation as supply piping. The J∆S Engineering Suite automatically

specifies insulation thickness in the piping schedule output.

7.9 Legionella Prevention (ASHRAE 188)
The Domestic Hot Water module includes Legionella risk assessment per ASHRAE Guideline 12 and Standard 188:

• Storage temperature: Maintain at 140 deg F minimum.

• Distribution temperature: Maintain above 124 deg F at all points in the recirculation loop.

• Dead legs: Limit stagnant pipe sections to less than 3 times the pipe diameter in length.

• Recirculation: Maintain continuous flow during occupied hours.

• Flush protocol: Periodic thermal disinfection at 160 deg F for 30 minutes.

8. Gas Piping

8.1 Overview
The Gas Pipe Sizer module (gas_pipe_app.py) provides professional gas pipe sizing per the International Fuel Gas Code

(IFGC), NFPA 54, and CPC Chapter 12.

Supported gas types:

• Natural Gas (specific gravity 0.60, heating value ~1,000 BTU/CF)

• Propane / LP Gas (specific gravity 1.52, heating value ~2,500 BTU/CF)

Supported pipe materials:

• Schedule 40 Black Steel (most common for commercial)

• CSST (Corrugated Stainless Steel Tubing)

• Copper (Type L or ACR)

• PE (Polyethylene, for underground exterior only)

8.2 Gas Load Inventory
All gas-fired appliances are listed with their input ratings in MBH (thousands of BTU per hour) and CFH (cubic feet per

hour). For natural gas, the conversion is approximately: 1 MBH approximately equals 1 CFH (since 1,000 BTU/CF).

Example gas load schedule:
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Appliance Location Input Rating (MBH) Input Rating (CFH)

Hot Water Boiler (heating) Mechanical Room, Floor 1 384 384

DHW Water Heater Mechanical Room, Floor 1 150 150

Break Room Range/Oven Break Room, Floor 1 75 75

Total Connected Load 609 MBH 609 CFH

8.3 Longest Run Method
The IFGC/CPC provides pipe sizing tables based on the longest run from the gas meter to the farthest appliance. The

"longest run" method sizes all pipe segments based on this single longest distance, which simplifies the calculation and

provides built-in conservatism.

System parameters:

Parameter Value

Service pressure (from utility) 2 psi (available at meter)

Appliance manifold pressure 14 in. WC (0.5 psi)

Allowable pressure drop 1.5 psi (2.0 - 0.5)

Longest run (meter to break room range, Floor 1) 150 ft

Specific gravity of natural gas 0.60

Pipe material Schedule 40 black steel

IFGC / CPC Table 1216.2 (2 psi systems, 150 ft longest run):

Pipe Size (in) Max CFH Capacity

1/2" 56

3/4" 121

1" 254

1-1/4" 510

1-1/2" 786

2" 1,590

2-1/2" 2,630

3" 4,370

8.4 Spitzglass Formula
For low-pressure gas systems (less than 1.5 psi), the software uses the Spitzglass formula:

Q = 3550 x K x sqrt((h x D^5) / (L x S_g x (1 + 3.6/D + 0.03 x D)))
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Where:
Q = gas flow (CFH)
K = constant based on pipe schedule
h = pressure drop (in. WC)
D = internal pipe diameter (inches)
L = pipe length (feet)
S_g = gas specific gravity (0.60 for natural gas)

8.5 Weymouth Formula
For high-pressure gas systems (above 1.5 psi), the software uses the Weymouth formula:

Q = 18.062 x D^(8/3) x sqrt((P1^2 - P2^2) / (S_g x L))

Where:
Q = gas flow (CFH)
D = internal pipe diameter (inches)
P1 = upstream pressure (psia)
P2 = downstream pressure (psia)
S_g = specific gravity
L = pipe length (feet)

8.6 Pipe Sizing Results -- Worked Example

Segment Load (CFH) Longest Run (ft) Pipe Size

Meter to mechanical room main 609 150 1-1/2" (786 CFH capacity)

Branch to boiler 384 50 1-1/4" (510 CFH)

Branch to DHW heater 150 40 1" (254 CFH)

Branch to break room range 75 150 3/4" (121 CFH)

8.7 Gas Meter Sizing
The gas utility sizes and provides the meter, but the engineer must specify the required capacity on the utility application.

For 609 CFH at 2 psi service pressure, a standard AL-425 diaphragm meter (capacity 425 CFH) may be insufficient.

Specify a rotary meter rated for 800+ CFH or request the utility to verify meter sizing.

8.8 BTU Demand Calculations for Common Equipment

Equipment Typical Input Range (MBH) Notes

Residential furnace 40-120 80% to 98% AFUE

Commercial rooftop unit 50-400 Gas heat section

Boiler (condensing) 100-2,000 95-98% thermal efficiency

Boiler (non-condensing) 100-6,000 80-85% thermal efficiency

Water heater (storage) 30-750 Tank type
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Equipment Typical Input Range (MBH) Notes

Water heater (tankless) 100-400 On-demand

Commercial range 30-90 Per burner section

Commercial oven 25-75 Convection or deck

Deep fryer 80-150 Per vat

Steam kettle 50-200 Tilting or stationary

Clothes dryer (commercial) 30-75 Per unit

Unit heater 30-350 Gas-fired

Infrared heater 30-200 High or low intensity

Pool heater 100-500 Depending on pool volume

Generator 50-2,000+ Varies by kW rating

8.9 Gas Piping Notes
• All gas piping to be Schedule 40 black steel with threaded or welded joints per IFGC/CPC.

• A manual gas shutoff valve is required at each appliance and at the building entrance (CPC Section 1212.4 / IFGC

Section 409.5).

• Gas piping in concealed spaces must be protected from physical damage and tested at 1.5 times working pressure

before concealment.

• An earthquake shutoff valve is required at the meter for California projects (CPC Section 1210.1.1).

• Provide a gas pressure regulator at each appliance if the service pressure exceeds the appliance inlet pressure

rating.

• CSST must be bonded to the building grounding electrode system per IFGC Section 310.1.1 and manufacturer

instructions.

9. Storm Drainage

9.1 Overview
The Storm Drainage module (storm_drainage_app.py) provides complete storm water drainage design per IPC Chapter

11 / UPC Chapter 11. The module includes four tabs:

1. Rainfall & Location -- IPC/UPC rainfall rates, return periods, city lookup

2. Roof Drains & Vertical -- Roof drain sizing, leaders, overflow

3. Horizontal Piping -- Manning's equation, pipe materials, slope options

4. Results & Export -- Pipe schedule, capacities, export to TXT/CSV
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9.2 Design Rainfall Intensity
Storm drainage sizing begins with the local design rainfall intensity. The IPC uses a 60-minute duration, 100-year return

period storm as the default design event.

Sample rainfall rates by US city:

City Rainfall (in/hr) City Rainfall (in/hr)

Atlanta, GA 3.7 Miami, FL 4.0

Boston, MA 2.5 Minneapolis, MN 3.4

Chicago, IL 3.2 New York, NY 3.0

Dallas, TX 4.0 Phoenix, AZ 2.5

Denver, CO 2.8 Portland, OR 2.0

Houston, TX 4.5 Sacramento, CA 2.0

Los Angeles, CA 1.5 San Diego, CA 1.5

San Francisco, CA 2.5 Seattle, WA 2.0

The software includes NOAA Atlas 14 data for precise rainfall intensity at any US location.

9.3 Roof Drain Flow Calculation -- Rational Method
The total rainfall runoff from the roof is calculated using the rational method:

Q = C x I x A / 96.23

Where:
Q = flow rate (GPM)
C = runoff coefficient (1.0 for roofs)
I = rainfall intensity (in/hr)
A = roof area (SF)
96.23 = conversion constant (1 ft^2 x 1 in/hr = 1/96.23 GPM)

Worked Example (San Diego):

Q = 1.0 x 1.5 x 25,000 / 96.23
Q = 37,500 / 96.23
Q = 389.7 GPM

Design roof drainage flow: approximately 390 GPM

9.4 Roof Drain and Leader Sizing (IPC Table 1106.2 / UPC Table 1103.1)
Vertical leaders (roof drain downspouts) are sized from code tables based on GPM flow:

Leader Size (in) Max GPM at 1 in/hr Max GPM at 1.5 in/hr Max GPM at 2 in/hr

2" 23 34 46

3" 58 87 116
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Leader Size (in) Max GPM at 1 in/hr Max GPM at 1.5 in/hr Max GPM at 2 in/hr

4" 120 180 240

5" 208 311 415

6" 359 538 717

8" 768 1,152 1,536

Sizing for this project (390 GPM at 1.5 in/hr):

• Using 4" leaders (180 GPM each): 390 / 180 = 2.17 -- minimum 3 roof drains with 4" leaders

• Using 5" leaders (311 GPM each): 390 / 311 = 1.25 -- minimum 2 roof drains with 5" leaders

Typical design: provide 4 roof drains with 4" leaders (one per quadrant) for balanced drainage. Each drain handles

approximately 98 GPM, well within the 180 GPM capacity.

9.5 Horizontal Storm Drain Sizing
The horizontal storm drain collecting all leaders is sized per code tables for horizontal pipe:

Pipe Size (in) Max GPM at 1/8"/ft Slope Max GPM at 1/4"/ft Slope Max GPM at 1/2"/ft Slope

3" 50 72 102

4" 145 204 289

5" 260 368 520

6" 425 600 849

8" 930 1,315 1,860

10" 1,650 2,330 3,300

12" 2,700 3,810 5,400

For 390 GPM at 1/8"/ft slope: 6" pipe handles 425 GPM. Select 6" horizontal storm drain at 1/8"/ft slope.

9.6 Overflow (Secondary) Drain Sizing
Per IPC Section 1107 / UPC Section 1101.11.1, a secondary (overflow) drainage system is required for roofs where

ponding could cause structural failure. The overflow system must be sized for the full primary design rainfall rate, and the

overflow drains are set 2 inches above the primary roof drain:

Q_overflow = C x I x A / 96.23
Q_overflow = 1.0 x 1.5 x 25,000 / 96.23 = 390 GPM

Provide 4 overflow drains with 4" leaders (matching or exceeding primary drain capacity). Overflow drains discharge to

grade via a visible location (exterior wall scupper or independent piping to daylight) to alert building occupants of primary

system failure.

9.7 Controlled Flow (Detention) Systems
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Where local jurisdictions require storm water detention to limit discharge rate, the Storm Drainage module can calculate

detention volumes using the Modified Rational Method:

V_detention = (Q_inflow - Q_allowable) x t x 60 / 7.48

Where:
V_detention = detention volume (gallons)
Q_inflow = peak inflow (GPM)
Q_allowable = maximum permitted discharge rate (GPM)
t = storm duration (minutes)

10. Backflow Prevention

10.1 Overview
Backflow prevention protects the potable water supply from contamination due to backpressure or back-siphonage. The

plumbing code requires specific types of backflow prevention based on the degree of hazard and the cross-connection

type.

10.2 Types of Backflow Prevention Devices

Device Abbreviation Hazard Level Testable Typical Application

Reduced Pressure
Backflow Assembly

RPBA (RP) High Yes Fire sprinkler
connections, boiler
makeup, chemical feed,
irrigation with fertilizer

Double Check Valve
Assembly

DCVA (DC) Moderate Yes HVAC cooling tower
makeup, swimming pool
fill, standard irrigation

Atmospheric Vacuum
Breaker

AVB Low No Hose bibbs, individual
fixtures above flood rim

Pressure Vacuum
Breaker

PVB Low-Moderate Yes Irrigation systems,
continuous pressure
applications

Air Gap AG Any (highest protection) N/A Receptacle/vessel (e.g.,
roof tank fill, commercial
dishwasher)

Spill-Resistant Vacuum
Breaker

SVB Low No Laboratory fixtures, dental
units

Dual Check Valve DuC Low No Residential service
connections in some
jurisdictions

10.3 When Each Type is Required
High-hazard cross-connections (RPBA or Air Gap required):
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• Fire sprinkler systems with chemical additives

• Boiler connections (chemical treatment in loop)

• Medical aspirator systems

• Chemical dispensing or industrial processes

• Irrigation with chemical injection (fertilizer, herbicide)

• Laboratory equipment with hazardous fluids

• Mortuary equipment

Moderate-hazard cross-connections (DCVA acceptable):

• Fire sprinkler systems (no chemical additives)

• HVAC cooling tower makeup water

• Swimming pool fill lines

• Standard landscape irrigation (no chemicals)

• Commercial laundry connections

Low-hazard cross-connections (AVB, PVB, or SVB acceptable):

• Hose bibbs (individual)

• Residential irrigation (no chemicals)

• Individual fixtures with below-rim supply (e.g., bathtub hand shower)

10.4 Sizing Backflow Preventers
Backflow preventers are sized based on the design flow rate (GPM) and the acceptable pressure loss. Typical pressure

losses through backflow prevention devices:

Device Pressure Loss at Design Flow

RPBA 10-15 psi

DCVA 3-8 psi

PVB 5-10 psi

AVB 1-3 psi

Air Gap 0 psi (but requires break tank and re-pump)

For the example project, the building main supply requires a DCVA (fire sprinkler system with no chemical additives) or

RPBA (if local AHJ requires higher protection):

• Flow: 55 GPM

• Pressure loss through 2" DCVA: approximately 5 psi

• Pressure loss through 2" RPBA: approximately 12 psi

10.5 Installation Requirements
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• All testable backflow prevention assemblies (RPBA, DCVA, PVB) must be accessible for annual testing.

• RPBAs must be installed with adequate drainage provisions because the relief valve can discharge water.

• Minimum clearance: 12" from floor to bottom of assembly, 12" between assemblies.

• RPBAs cannot be installed in pits or below grade in most jurisdictions.

• Thermal expansion protection is required downstream of backflow preventers per IPC Section 607.3.

11. Water Heater Sizing

11.1 Storage vs. Tankless Selection
The Hot Water Sizing module compares storage and tankless water heater options:

Parameter Storage Tankless Heat Pump

Recovery rate Moderate (30-90 gal/hr typical) Unlimited (on-demand) Low (60-80 gal/hr typical)

First hour rating High (storage + recovery) Equal to flow rate Moderate

Standby loss 2-5% of stored energy None 2-4%

Space requirement Large (tank footprint) Small (wall-mounted) Medium

Energy efficiency 80-96% (gas), 90-95% (electric) 82-99% (gas), 99% (electric) 200-400% (COP 2-4)

Capital cost Moderate Moderate-High High

Best application High peak demand Low-moderate steady demand Moderate demand, low energy
cost priority

11.2 Recovery Rate and First Hour Rating
Recovery rate is the amount of hot water a heater can produce in one hour when starting with a full tank at setpoint

temperature:

Recovery Rate (GPH) = Heater Output (BTU/hr) / (500 x Delta_T / 60)
= Heater Output / (8.33 x Delta_T)

First Hour Rating (FHR) is the total hot water the system can deliver in the first hour, which equals storage volume plus

one hour of recovery:

FHR = Storage Volume (gal) x 0.70 (usable fraction) + Recovery Rate (GPH)

For the example project:

• Storage: 100 gal x 0.70 = 70 gal usable

• Recovery: 150 MBH / (8.33 x 80) = 225 GPH

• FHR = 70 + 225 = 295 GPH

11.3 Manufacturer Equipment Data
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The software includes manufacturer data for equipment selection:

Manufacturer Product Lines Types

A.O. Smith Cyclone, BTH, BTC series Gas storage, condensing

Bradford White eF Series, Brute Gas storage, condensing, electric

Rheem GHE, Marathon, Triton Gas, electric, tankless

Navien NPE, NCB series Tankless, combi boiler

Rinnai RU, RL, RSC series Tankless

Lochinvar ARMOR, KNIGHT, Shield Condensing storage, fire-tube

11.4 Energy Comparison
The Hot Water Sizing module provides annual energy cost comparison between gas, electric, and heat pump water

heaters:

Annual Cost (Gas) = (Daily Demand x 365 x 8.33 x Delta_T) / (Efficiency x 100,000) x $/therm
Annual Cost (Electric) = (Daily Demand x 365 x 8.33 x Delta_T) / (Efficiency x 3,412) x $/kWh
Annual Cost (Heat Pump) = (Daily Demand x 365 x 8.33 x Delta_T) / (COP x 3,412) x $/kWh

11.5 Diversity Factors by Building Type

Building Type Diversity Factor Application

Residential 0.30 Peak overlaps are moderate

Office 0.30 Morning arrival + lunch peaks

Hotel 0.35 Morning shower peak

Restaurant 0.40 Meal service peaks

Hospital 0.25 Continuous demand, lower peaks

School 0.40 Morning + lunch peaks

Gym/Fitness 0.50 Post-workout shower peaks

12. Grease Interceptor Sizing

12.1 Overview
The Grease Interceptor module (grease_interceptor_app.py) sizes grease interceptors for commercial food service

establishments using four code-approved methods:

1. PDI G101 -- Plumbing & Drainage Institute method (most widely used)

2. UPC method -- Fixture unit based
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3. IPC method -- Flow rate based

4. Direct flow rate -- Engineering judgment when fixture count is unknown

12.2 PDI G101 Method
The PDI G101 method calculates the required grease interceptor flow rate based on fixture drainage capacity and loading

factors:

Required Flow Rate (GPM) = (Total Fixture Drainage Capacity) x Loading Factor x Occupant Factor

Where:
Fixture Drainage Capacity = sum of all fixture drains x 75% fill factor
Loading Factor = 1.0 (low), 1.5 (medium), 2.0 (high)

Fixture drainage capacities per PDI G101:

Fixture Type Drainage Capacity (GPM) Fixture Units

3-Compartment Sink 75.0 3

2-Compartment Sink 50.0 2

Single Compartment Sink 25.0 1

Pre-Rinse Spray 5.0 1

Pot Sink 50.0 2

Mop Sink 20.0 1

Floor Drain (kitchen) 20.0 1

Dishwasher (under counter) 15.0 1

Dishwasher (rack type) 25.0 1

Wok Range 30.0 1

Steam Table 10.0 1

Ice Cream Cabinet 10.0 1

Loading factors:

Loading Factor Description

Low 1.0 Cafeteria, no fryer

Medium 1.5 Short-order cooking

High 2.0 Full menu, fryers, wok

12.3 Interceptor Types

Type Abbreviation Flow Rate Range Application

Under-Sink / Point-of-Use POU 10-50 GPM Individual fixtures
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Type Abbreviation Flow Rate Range Application

Hydromechanical (HGI) HGI 10-200 GPM Small to medium kitchens

Gravity Grease Interceptor (GGI) GGI 20-500+ GPM Large kitchens, multiple fixtures

In-Ground IG 50-3,000+ GPM High-volume facilities, central
systems

Above-Ground Recovery Unit AGRU 10-100 GPM Space-constrained installations

12.4 Manufacturer Data
The module includes equipment data from five major manufacturers:

• Schier -- Great Basin series

• Watts -- Grease interceptors and separators

• Zurn -- GT series

• Highland Tank -- Steel grease interceptors

• Thermaco -- Big Dipper, Trapzilla series

13. Waste Pipe Invert Calculations

13.1 Overview
The Waste Pipe Invert module (waste_invert_app.py) calculates invert elevations for gravity drainage systems. Proper

invert calculations ensure that drainage pipes maintain the required slope and connect correctly at manholes, cleanouts,

and building transitions.

13.2 Invert Elevation Formula
Invert_downstream = Invert_upstream - (Length x Slope)

Where:
Invert = elevation of the inside bottom of the pipe (feet)
Length = horizontal run of the pipe (feet)
Slope = pipe slope (ft/ft), e.g., 1/8"/ft = 0.0104 ft/ft

13.3 Slope Conversions

Slope (in/ft) Slope (ft/ft) Slope (%)

1/16" per ft 0.0052 0.52%

1/8" per ft 0.0104 1.04%

1/4" per ft 0.0208 2.08%

1/2" per ft 0.0417 4.17%
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Slope (in/ft) Slope (ft/ft) Slope (%)

1" per ft 0.0833 8.33%

13.4 Crown vs. Invert
• Invert = inside bottom of the pipe

• Crown = inside top of the pipe

• Obvert = outside top of the pipe (invert + pipe OD)

When pipes of different sizes connect at a manhole or junction, the crowns should be aligned (crown-matching) rather than

inverting matching, to prevent surcharging of the smaller pipe.

13.5 Minimum Cover
Building sewers must maintain minimum cover (depth from finished grade to top of pipe) to prevent damage from surface

loads:

Location Minimum Cover

Under building slab Per structural engineer

Under paved areas (light traffic) 12"

Under paved areas (heavy traffic) 18"

Under unpaved areas 12"

Under roadways 36" (varies by jurisdiction)

Subject to frost Below frost depth

14. Water Pressure Analysis

14.1 Overview
The Water Pressure Calculator (water_pressure_app.py) performs a complete IPC Chapter 6 / UPC domestic water

pressure analysis to determine whether the available street pressure is adequate to serve all fixtures, or whether a booster

pump is needed.

14.2 Pressure Budget Method
The available pressure at the highest, most remote fixture is calculated by subtracting all losses from the available street

pressure:

P_available = P_street - P_meter - P_backflow - P_static - P_friction - P_fittings

Where:
P_street = static pressure at the water main (psi)
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P_meter = pressure loss through water meter (psi)
P_backflow = pressure loss through backflow preventer (psi)
P_static = static head loss due to elevation (psi) = H / 2.31
P_friction = friction loss in piping (psi)
P_fittings = additional loss for fittings (typically 50% of pipe friction)

14.3 Pressure Budget -- Worked Example

Item Value Units

Street pressure (given by utility) 60 psi

Minus: Water meter loss -8 psi

Minus: Backflow preventer (DCVA) loss -5 psi

Minus: Static head (4 stories x 14 ft = 56 ft /
2.31)

-24.2 psi

Minus: Friction loss in piping (est. 3 psi/100 ft
x 200 ft EL)

-6 psi

Minus: Fitting losses (50% of friction) -3 psi

Available at top-floor fixture 13.8 psi

The minimum residual pressure required for a flushometer valve is 15 psi (IPC Table 604.3). Since 13.8 psi is below 15

psi, a domestic water booster pump is required.

14.4 Booster Pump Sizing
When available pressure is insufficient:

• Flow: Building peak demand (55 GPM)

• Required discharge pressure: Calculate to provide minimum residual at top fixture

• Boost required: (Required pressure at fixture + losses) - Available inlet pressure

For this project:

• Required at fixture: 15 psi

• Total losses above inlet: 24.2 + 6 + 3 = 33.2 psi

• Required pump discharge: 15 + 33.2 = 48.2 psi

• Available inlet (after meter + BFP): 60 - 8 - 5 = 47 psi

• Boost required: 48.2 - 47 = 1.2 psi minimum -- a marginal case. For safety margin, specify a booster pump with 20
psi minimum boost at 55 GPM.

Select duplex variable-speed booster package rated 55 GPM at 50 ft TDH (21.6 psi) with VFD for energy efficiency and

constant pressure control.

14.5 Equivalent Length of Fittings
The Water Pressure Calculator includes a fittings library for equivalent length calculations:
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Fitting Equivalent Length (ft of pipe)

90-degree elbow (standard) 2.5 x pipe diameter

90-degree elbow (long radius) 1.5 x pipe diameter

45-degree elbow 1.2 x pipe diameter

Tee (straight through) 1.5 x pipe diameter

Tee (branch) 5.0 x pipe diameter

Gate valve (full open) 0.5 x pipe diameter

Globe valve (full open) 17 x pipe diameter

Ball valve (full open) 0.5 x pipe diameter

Check valve (swing) 6.0 x pipe diameter

Butterfly valve 2.0 x pipe diameter

15. Pipe Network Analysis

15.1 Overview
The Pipe Network module (pipe_network_app.py) provides detailed pipe network analysis for hydronic systems using the

Darcy-Weisbach equation and Colebrook-White equation for friction factor determination. While primarily designed for

HVAC hydronic systems, it is also applicable to domestic water distribution networks.

15.2 Darcy-Weisbach Equation
h_f = f x (L/D) x (V^2 / (2g))

Where:
h_f = friction head loss (ft)
f = Darcy friction factor (dimensionless)
L = pipe length (ft)
D = pipe internal diameter (ft)
V = flow velocity (fps)
g = acceleration due to gravity (32.174 ft/s^2)

15.3 Colebrook-White Equation
The Darcy friction factor is determined iteratively from the Colebrook-White equation:

1/sqrt(f) = -2.0 x log10((e/D)/3.7 + 2.51/(Re x sqrt(f)))

Where:
e = pipe absolute roughness (ft)
D = pipe internal diameter (ft)
Re = Reynolds number = V x D / kinematic_viscosity
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15.4 Pipe Roughness Values

Material Absolute Roughness (ft)

Copper 0.000005

Steel (new) 0.00015

Steel (10-year) 0.0004

Steel (20-year) 0.001

Stainless Steel 0.000015

PVC 0.000005

CPVC 0.000005

HDPE 0.000005

Ductile Iron 0.00085

Cast Iron 0.00085

15.5 Applications
• Multi-branch domestic water supply verification

• Hot water recirculation loop balancing

• Large building riser analysis

• Hydronic heating/cooling pipe sizing

16. Code Compliance -- IPC, CPC, UPC Differences

16.1 Overview of Plumbing Codes
Three primary plumbing codes are used in the United States:

Code Full Name Publisher Adoption

IPC International Plumbing Code ICC ~35 states, federal buildings

UPC Uniform Plumbing Code IAPMO ~13 states (including CA, AZ, NV)

CPC California Plumbing Code CBSC California (based on UPC with
state amendments)

The J∆S Engineering Suite's IPC/CPC Plumbing reference module (accessible from References & Standards > IPC/CPC
Plumbing) provides a searchable cross-reference between these codes.

16.2 Key Differences Between IPC and UPC
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Topic IPC 2021 UPC 2022

Fixture units (WC flush valve) 5 WSFU 10 WSFU

Hunter's curve source IPC Appendix E UPC Appendix A

Drainage sizing table IPC Table 710.1 UPC Table 702.1

Vent sizing table IPC Table 916.1 UPC Table 703.2

Circuit venting Permitted (Section 911) Permitted (Section 908)

Air admittance valves (AAV) Permitted (Section 917) Not permitted in most UPC jurisdictions

Combination waste and vent Permitted (Section 910) Permitted with restrictions

Wet venting Extensive provisions (Section 912) More limited

Gas piping reference IFGC (separate code) CPC Chapter 12 (integrated)

Maximum building drain slope No upper limit specified 1/2"/ft maximum for 3" and larger

16.3 When Each Code Applies

Jurisdiction Code

California CPC 2022 (based on UPC + state amendments)

Arizona, Nevada, Oregon, Washington UPC 2022

Most other states IPC 2021

Federal buildings (GSA, DOD) IPC 2021 (typically)

International (some countries) IPC-based

16.4 Code Selection in the Software
When creating a new project, the Fixture Calculator module asks you to select the governing plumbing code. This selection

affects:

• WSFU and DFU values used in calculations

• Hunter's Curve data source

• Drainage capacity tables

• Vent sizing tables

• Minimum fixture count requirements (IPC Table 403.1 vs. CPC/CBC Table 422.1)

• Gas piping reference (IFGC vs. CPC Chapter 12)

The default code is IPC 2024. Change to UPC or CPC in the module settings or in the Project Settings dialog.

17. Step-by-Step Walkthroughs for Each Module
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17.1 Fixture Calculator (plumbing_calcs_app.py)
Tab 1: Fixture Units

1. In the Code dropdown, select "IPC 2021", "UPC 2022", or "CPC 2022".

2. In the Flush Type dropdown, select "Flush Valve" or "Flush Tank".

3. Enter the Number of Floors.

4. In the fixture table, set the Quantity for each fixture type present in the building.

5. The software auto-fills WSFU (Cold, Hot, Total) and DFU columns based on the selected code.

6. Review the Summary panel showing total WSFU (cold, hot, combined) and total DFU.

7. Red warning banners appear if fixture counts are below code minimums.

Tab 2: Water Supply

1. The total WSFU from Tab 1 is carried forward automatically.

2. The software performs Hunter's Curve interpolation to calculate Peak GPM.

3. Select the Pipe Material (Type L Copper, CPVC, PEX, etc.).

4. Set the Maximum Velocity (default 8 fps).

5. The software sizes the building main, risers, and branch lines.

6. Review the pipe schedule table with segment ID, WSFU, GPM, pipe size, velocity, and material.

Tab 3: Drainage

1. Total DFU from Tab 1 is carried forward.

2. Select the desired Pipe Slope (1/8"/ft or 1/4"/ft).

3. Select the Drain Pipe Material (cast iron, PVC, ABS, etc.).

4. The software sizes the building drain, branch drains, and soil/waste stacks.

5. Manning's equation verification is shown alongside the table method.

6. A separate section calculates vent pipe sizes based on connected DFU and developed length.

Tab 4: DHW (Domestic Hot Water)

1. Enter the building type and occupancy count.

2. Enter the Inlet Water Temperature and Storage Temperature.

3. The software calculates peak demand, storage volume, and recovery rate.

4. Basic water heater sizing is provided; for detailed DHW design, use the dedicated modules.

Tab 5: Gas Pipe

1. Add gas appliances with their input ratings in MBH or CFH.

2. Enter the Longest Run distance from meter to farthest appliance.

3. Select the Gas Type (natural gas or propane) and Pipe Material (Sch 40 steel, CSST, etc.).

4. Enter the Service Pressure and Allowable Pressure Drop.

5. The software sizes each segment and produces a gas piping schedule.
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Tab 6: Storm Drainage

1. Enter the Rainfall Intensity (in/hr) or select a city for automatic lookup.

2. Enter the Roof Area (SF) and Runoff Coefficient (default 1.0 for roof).

3. The software calculates total runoff flow (GPM).

4. Enter the number and size of roof drains desired.

5. The software verifies capacity and sizes horizontal storm drains.

Tab 7: Water Pressure

1. Enter the Street Pressure (psi).

2. Enter the Elevation Change from meter to highest fixture (ft).

3. Enter the Total Pipe Length (ft) and select pipe material.

4. Enter losses for meter, backflow preventer, and PRV (if applicable).

5. The software calculates available pressure at the remote fixture.

6. If pressure is insufficient, a booster pump recommendation is generated.

Tab 8: Reports

1. Click Generate Report to compile all calculations.

2. Select export format: PDF, Excel, or TXT.

3. The report includes all pipe schedules, fixture schedules, and compliance summaries.

17.2 Water Pressure Calculator (water_pressure_app.py)
1. Launch from Plumbing Tools > Water Pressure Calc.

2. Fixture Schedule Tab: Add fixtures from the dropdown (bathtub, WC, lavatory, urinal, etc.) and enter quantities.

Each fixture shows its WSFU and minimum required pressure.

3. Pipe Sizing Tab: Select pipe material from the dropdown (Type L Copper, CPVC, PEX, Galvanized Steel, Ductile

Iron, Stainless Steel). The software calculates pipe size based on the total WSFU and velocity limit.

4. Pressure Analysis Tab: Enter street pressure, meter size, backflow preventer type, elevation change, and pipe

routing details. The software computes the complete pressure budget from street to fixture.

5. Export: Save the analysis as PDF or Excel for inclusion in the plumbing submittal package.

17.3 Gas Pipe Sizer (gas_pipe_app.py)
1. Launch from Plumbing Tools > Gas Pipe Sizer.

2. Appliance Tab: Add appliances from the built-in library or enter custom equipment with BTU/hr input ratings.

3. System Parameters Tab: Set gas type (natural gas or propane), service pressure, allowable pressure drop,

specific gravity, and pipe material.

4. Pipe Sizing Tab: Enter the layout as a series of segments with from/to labels, pipe length, and connected load.

The software selects pipe sizes per the longest-run method and verifies with Spitzglass or Weymouth formulas.

5. Results Tab: Review the pipe sizing schedule. Export to PDF, TXT, or CSV.
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17.4 Storm Drainage (storm_drainage_app.py)
1. Launch from Plumbing > Storm Drainage.

2. Rainfall & Location Tab: Select a US city from the dropdown for automatic rainfall intensity lookup, or enter

custom values. Set the return period (10, 25, 50, or 100 year).

3. Roof Drains & Vertical Tab: Enter roof area, number of roof sections, and drain type. The software calculates

required number and size of roof drains and vertical leaders. Secondary (overflow) drain sizing is calculated

automatically.

4. Horizontal Piping Tab: Enter horizontal storm drain layout with lengths and slopes. Select pipe material.

Manning's equation is used to verify pipe capacity.

5. Results & Export Tab: Review complete storm drainage pipe schedule. Export to TXT or CSV.

17.5 Hot Water Sizing (hot_water_app.py)
1. Launch from Plumbing Tools > Hot Water Sizing.

2. Building & Fixtures Tab: Select building type (Office, Hotel, Restaurant, Hospital, School, Gym, Residential).

Enter occupancy count. Add fixtures with quantities.

3. Demand Calc Tab: The module calculates demand using three methods simultaneously -- ASHRAE

storage/recovery method, Modified Hunter's Curve, and UPC fixture unit method. Select the governing method or use

the most conservative result.

4. Heater Selection Tab: Browse manufacturer equipment data. Filter by type (gas storage, electric storage, gas

tankless, electric tankless, heat pump). The software recommends equipment based on the calculated demand.

5. Recirculation & Results Tab: Design the recirculation loop with pipe sizing, pump selection, and heat loss

calculation. View annual energy cost comparison between gas, electric, and heat pump options. Export complete

DHW design report.

17.6 Domestic Hot Water (domestic_hot_water_app.py)
1. Launch from Plumbing Tools > Domestic Hot Water.

2. Fixture Count Tab: Enter all hot-water-connected fixtures with quantities. Each fixture shows its GPH demand,

WSFU, and required delivery temperature.

3. System Design Tab: Select heater type, storage temperature, mixing valve configuration, and Legionella

prevention strategy (per ASHRAE 188).

4. Pipe Sizing Tab: Design the hot water distribution system including supply risers, branch piping, and recirculation

return. Enter pipe lengths and the software calculates sizes, heat losses, and insulation requirements.

5. Equipment Selection Tab: Select specific manufacturer equipment based on calculated demand. View equipment

data sheets and compare options.

6. Compliance & Export Tab: Generate a compliance checklist covering ASHRAE 90.1 insulation, ASSE 1017

mixing, ASHRAE 188 Legionella, and code-required minimum delivery temperatures. Export the complete DHW

report.

17.7 Grease Interceptor (grease_interceptor_app.py)
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1. Launch from Plant / System Tools > Grease Interceptor.

2. Select the Sizing Method (PDI G101, UPC, IPC, or Flow Rate).

3. Add kitchen fixtures from the dropdown with their drainage capacities.

4. Select the Loading Factor (Low, Medium, High).

5. The software calculates the required interceptor flow rate (GPM) and recommended interceptor type.

6. Browse manufacturer equipment and select a specific model.

7. Export the sizing report for inclusion in the plumbing specifications.

17.8 Pipe Sizer (pipe_sizer_app.py)
1. Launch from Core Calculations > Pipe Sizer.

2. Select the Fluid (water, glycol solution, refrigerant, steam) and enter temperature and flow rate (GPM).

3. Select the Pipe Material and the software auto-populates roughness values.

4. Choose the sizing method: Hazen-Williams or Darcy-Weisbach.

5. The software calculates the minimum pipe size to meet the velocity limit and maximum friction loss criteria.

6. For multi-segment systems, enter each segment and the software produces a complete pipe schedule.

18. Common Design Mistakes

18.1 Water Supply Sizing Mistakes

Mistake Consequence Correct Approach

Using UPC WSFU values (10 for flush-valve
WC) with IPC Hunter's Curve

Oversized piping, wasted cost Match WSFU table to curve: use IPC 604.3
with IPC Appendix E

Ignoring future fixture additions Undersized piping when tenant adds fixtures Design with 20% spare capacity on mains

Forgetting elevation head loss Insufficient pressure at upper floors Always include P_static = height / 2.31

Using 10 fps velocity for copper Water hammer, erosion, noise Limit to 8 fps for copper per ASME B31.9

Not accounting for pressure loss through BFP Available pressure appears higher than reality Include 5-15 psi loss for DCVA/RPBA

Sizing pipe at peak WSFU without diversity Oversized pipe with excessive cost Apply floor diversity when aggregating risers

18.2 Drainage Sizing Mistakes

Mistake Consequence Correct Approach

Using horizontal drain capacity for vertical
stacks

Undersized stacks Use separate vertical stack tables (higher
DFU capacity)

Exceeding max DFU per branch interval on
stacks

Surcharging, overflow Check per-branch limit, not just total
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Mistake Consequence Correct Approach

Slope too steep on large drain pipes Self-scouring leaves solids behind (water
outruns waste)

Maximum 1/2"/ft for 3" and larger per UPC

Not providing cleanout access Code violation, impossible maintenance Cleanouts at every change of direction and
every 100 ft

Connecting storm drains to sanitary system Code violation, overloaded sanitary system Separate storm and sanitary unless combined
sewer jurisdiction

18.3 Vent Sizing Mistakes

Mistake Consequence Correct Approach

Undersized vent pipes Trap siphonage, gurgling, sewer gas entry Follow code vent sizing tables with developed
length

Vent termination too close to intake Sewer gas drawn into building Maintain 10 ft minimum from any air intake or
operable opening

No relief vent on long circuit-vented battery Pressure problems, trap siphonage Add relief vent per IPC 911.2 for more than 4
water closets

Using AAV where not permitted Code violation (UPC jurisdictions) Verify AAV acceptance with local AHJ

18.4 Hot Water System Mistakes

Mistake Consequence Correct Approach

Setting storage below 140 deg F Legionella growth risk Store at 140 deg F minimum per ASHRAE
188

No mixing valve for public lavatories Scald risk, liability Provide ASSE 1070 TMVs limiting to 110 deg
F

Undersized recirculation pump Warm-up wait time, water waste Calculate heat loss and size pump for loop
flow

No thermal expansion tank downstream of
BFP

Pressure spikes, relief valve weeping Install expansion tank per IPC 607.3

Single water heater with no redundancy Complete loss of hot water on failure Provide duplex heaters or N+1 configuration
for critical facilities

18.5 Gas Piping Mistakes

Mistake Consequence Correct Approach

Using pipe length to appliance instead of
longest run

Undersized piping Always use longest run from meter to farthest
appliance for all segments

Not accounting for future appliance additions Undersized gas main Size main for full connected load + 20% spare

Missing earthquake shutoff (California) Code violation, safety hazard Required at meter per CPC 1210.1.1
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Mistake Consequence Correct Approach

No drip leg at appliance connections Moisture/debris damage to appliance Provide sediment trap (drip leg) per IFGC
408.4

Using CSST without proper bonding Lightning/electrical damage risk Bond CSST to building grounding electrode
per IFGC 310.1.1

18.6 Storm Drainage Mistakes

Mistake Consequence Correct Approach

Using inadequate rainfall intensity Undersized system, flooding Use 100-year, 60-min storm per code (local
AHJ may require different)

Forgetting overflow (secondary) drains Structural failure risk from ponding Provide secondary system sized equal to
primary per IPC 1107

Connecting primary and overflow to same
piping

Defeats purpose of redundancy Overflow must discharge independently (to
grade or separate system)

Not accounting for vertical wall runoff Undersized drain capacity Include 50% of largest adjacent vertical
surface per IPC 1106.6

19. Integration with Revit

19.1 Overview
The J∆S Engineering Suite includes a Revit connector (revit_connector.py) that provides bidirectional data exchange

between the desktop software and Autodesk Revit. The connector supports plumbing data through the PlumbingFixture

and PlumbingResult data classes.

19.2 Importing Plumbing Fixtures from Revit
When you import a Revit model (.rvt or via the live connector), the software extracts:

• Plumbing fixture data: Fixture type, category, count, location, level, flow rates, and IPC/UPC fixture units

• Piping summary: Pipe system types, lengths, sizes, and materials

• Space/room assignments: Which fixtures belong to which spaces

To import Revit plumbing data:

1. From the main menu, go to File > Import from Revit or use the Revit Add-in toolbar button.

2. In the Import Dialog, check the Import plumbing fixtures checkbox.

3. The software parses all Revit plumbing fixture families and populates the Fixture Calculator automatically.

4. Review the imported fixture schedule in the Fixtures tab.

19.3 Plumbing Data Structure from Revit
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The Revit connector creates a PlumbingFixture object for each fixture containing:

Field Type Description

fixture_type str Type name (e.g., "Water Closet", "Lavatory")

fixture_category str Category (e.g., "Plumbing Fixtures")

element_id int Revit element ID for back-reference

level str Floor/level name

x, y, z float 3D coordinates

flow_rate_cold float Cold water flow (GPM)

flow_rate_hot float Hot water flow (GPM)

wsfu_cold float Cold WSFU

wsfu_hot float Hot WSFU

wsfu_total float Total WSFU

dfu float Drainage fixture units

trap_size float Trap diameter (inches)

19.4 Exporting Results to Revit
After completing plumbing calculations, the software creates a PlumbingResult object that can be pushed back to the Revit

model:

Result Field Description

total_wsfu Building total WSFU

total_dfu Building total DFU

peak_demand_gpm Peak demand from Hunter's Curve

main_pipe_size Building main pipe size

main_drain_size Building drain size

fixture_counts Dictionary of fixture type to count

This data can be used to:

• Auto-size Revit pipe elements based on calculated flow rates

• Tag fixtures with their WSFU/DFU values in Revit schedules

• Generate plumbing riser diagrams annotated with calculated sizes

• Populate shared parameters for coordination with other disciplines

19.5 Revit Plumbing Workflow
1. In Revit: Place plumbing fixtures and route piping in the Revit model.
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2. Export from Revit: Use the J∆S Revit Add-in to export fixture and piping data.

3. In J∆S Engineering Suite: Import the Revit data. The Fixture Calculator auto-populates.

4. Run Calculations: Verify fixture counts, size piping, calculate drainage, and size water heaters.

5. Export Results: Push calculation results back to Revit for pipe sizing, schedules, and documentation.

6. Iterate: As the Revit model changes (fixtures added/removed), re-import and re-calculate.

20. Output Interpretation and Export

20.1 Plumbing Calculation Report
When you click Generate Report in any plumbing module, the J∆S Engineering Suite produces a comprehensive report

organized into the following sections:

1. Cover Sheet -- Project information, engineer of record, code basis

2. Fixture Schedule -- Tabulated list of all fixtures by floor, with WSFU and DFU assignments

3. Domestic Cold Water Sizing -- WSFU totals, Hunter's Curve flow, pipe sizing schedule, pressure analysis,

booster pump recommendation (if required)

4. Domestic Hot Water Sizing -- Hot water demand analysis, heater selection, storage tank sizing, recirculation

pump sizing, pipe insulation schedule

5. Sanitary Drainage -- DFU totals, building drain sizing, stack sizing, vent sizing, pipe material specification

6. Storm Drainage -- Rainfall data, roof drain sizing, leader and horizontal drain sizing, overflow drain sizing

7. Natural Gas Piping -- Appliance schedule, gas demand summary, pipe sizing schedule, meter requirement

8. Code Compliance Summary -- Checklist verifying conformance with IPC/UPC/CPC requirements

20.2 Reading the Pipe Sizing Tables
Each pipe sizing table in the report includes:

Column Description

Segment ID Reference identifier (e.g., DCW-01, SAN-03) matching the plumbing
riser diagram

From / To Origin and destination of the pipe segment

Fixture Units WSFU (supply) or DFU (drainage) served by the segment

Flow (GPM) Converted flow rate

Pipe Size Selected nominal pipe size

Material Pipe material (Type L copper, cast iron, Sch 40 steel, etc.)

Velocity (fps) Calculated velocity at design flow

Slope For drainage only -- slope in inches per foot
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Column Description

Notes Warnings, code references, or design notes

20.3 Exporting Results
All plumbing modules support multiple export formats:

• PDF -- Professional print-ready report with company letterhead. Suitable for submittal packages and plan check.

• Excel (.xlsx) -- Editable spreadsheet with all calculation tables for further analysis and client review.

• TXT -- Plain text summary for inclusion in specifications or email communication.

• CSV -- Comma-separated values for import into other software (e.g., Revit schedules, cost estimating tools).

To export, click File > Export from within any plumbing module and select the desired format.

20.4 Reviewing Warnings and Flags
The software highlights potential issues with color-coded flags:

Flag Color Meaning

Green All values within code limits and design standards

Yellow Value is within 10% of a code limit (e.g., pipe at 92% capacity). Review
recommended.

Red Code violation or engineering limit exceeded (e.g., velocity > 8 fps,
pressure below minimum, pipe over capacity). Must be corrected
before finalizing the report.

20.5 Cost Estimating Integration
The J∆S Engineering Suite's cost estimating module (accessible from the main menu) provides plumbing cost estimates

based on the calculated design:

Cost Category Basis

Fixtures (material) Per fixture type and quality level

Fixtures (labor) Per fixture type and regional labor rates

Piping (material) Per linear foot by pipe type, material, and size

Piping (labor) Per linear foot by pipe type and complexity

Water heater Per unit based on type, capacity, and manufacturer

Cost per fixture Total plumbing cost divided by fixture count

Cost per SF Total plumbing cost divided by building area

Benchmark data for plumbing costs by building type is included for comparison.
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21. Code References

21.1 Primary Codes

Code Full Title Publisher

IPC 2021 International Plumbing Code, 2021 Edition ICC

UPC 2022 Uniform Plumbing Code, 2022 Edition IAPMO

CPC 2022 California Plumbing Code, 2022 Edition (Title
24, Part 5)

CBSC

CBC 2022 California Building Code, 2022 Edition (Title
24, Part 2)

CBSC

IFGC 2021 International Fuel Gas Code, 2021 Edition ICC

21.2 Referenced Standards

Standard Title Application

ASME A112.19.2 Ceramic Plumbing Fixtures WC, urinal, lavatory specifications

ASME B31.9 Building Services Piping Pipe material, joints, pressure ratings

ASSE 1012 Backflow Preventer with Intermediate
Atmospheric Vent

DHW protection

ASSE 1013 Reduced Pressure Principle Backflow
Prevention Assembly

Main DCW protection

ASSE 1016 Individual Thermostatic Compensating Valves Lavatory/shower mixing valves

ASSE 1017 Temperature Actuated Mixing Valves Central DHW tempering

ASSE 1070 Water Temperature Limiting Devices Scald prevention

ASHRAE 90.1-2022 Energy Standard for Buildings Pipe insulation, DHW efficiency

ASHRAE 188 Legionellosis: Risk Management for Building
Water Systems

Legionella prevention

ASHRAE Guideline 12 Minimizing the Risk of Legionellosis Supplemental guidance

NFPA 54 National Fuel Gas Code Gas piping (same as IFGC in most adoptions)

PDI G101 Testing and Rating for Grease Interceptors Grease interceptor sizing

ASTM B88 Seamless Copper Water Tube Type K, L, M copper pipe

CISPI 301 Cast Iron Soil Pipe Hubless cast iron drainage pipe

ASTM A53 Black and Hot-Dipped Zinc-Coated Welded
Steel Pipe

Gas piping material

ASCE 7-22 Minimum Design Loads for Buildings Rainfall intensity data

NSF/ANSI 61 Drinking Water System Components Materials in contact with potable water
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Standard Title Application

AWWA C651 Disinfection of Water Mains New pipe disinfection

MSS SP-69 Pipe Hangers and Supports Pipe support spacing

ASME B31.1 Power Piping Thermal expansion

21.3 Key Code Table References

Table Number Title Code Used For

IPC 403.1 Minimum Number of Required
Plumbing Fixtures

IPC Fixture count determination

CBC Table 422.1 Minimum Plumbing Facilities CBC/CPC Fixture count determination
(California)

IPC Table 604.3 Water Supply Fixture Units IPC WSFU assignment

IPC Table 604.4 Minimum Flow Rates for Fixtures IPC Minimum fixture pressures

UPC Table 610.3 Water Supply Fixture Units UPC WSFU assignment

IPC Table E103.3(2) Demand (GPM) vs. Fixture Units IPC Hunter's Curve (WSFU to GPM)

UPC Appendix A Demand (GPM) vs. Fixture Units UPC Hunter's Curve (WSFU to GPM)

IPC Table 709.1 Drainage Fixture Units IPC DFU assignment

UPC Table 702.1 Drainage Fixture Units UPC DFU assignment and drain sizing

IPC Table 710.1 Building Drain and Sewer Sizing IPC Horizontal drain sizing

IPC Table 710.1(1) Vertical Stack Sizing IPC Stack sizing

IPC Table 916.1 Size of Vents IPC Vent pipe sizing

UPC Table 703.2 Size of Vents UPC Vent pipe sizing

IPC Table 1106.2 Roof Drain Size IPC Storm drain sizing

UPC Table 1103.1 Roof Drain/Leader/Horizontal
Pipe

UPC Storm drainage sizing

IFGC Table 402.4 Gas Pipe Sizing (2 psi systems) IFGC Natural gas pipe sizing

CPC Table 1216.2 Gas Pipe Sizing (2 psi systems) CPC Natural gas pipe sizing
(California)

22. Abbreviations

Abbreviation Definition

AAV Air Admittance Valve

ABS Acrylonitrile Butadiene Styrene (drain pipe)
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Abbreviation Definition

ACR Air Conditioning and Refrigeration (copper tube)

AG Air Gap

AHJ Authority Having Jurisdiction

ASSE American Society of Sanitary Engineering

ASME American Society of Mechanical Engineers

AVB Atmospheric Vacuum Breaker

BFP Backflow Preventer

BTU British Thermal Unit

CBC California Building Code

CFH Cubic Feet per Hour

CFS Cubic Feet per Second

CPC California Plumbing Code

CPVC Chlorinated Polyvinyl Chloride

CSST Corrugated Stainless Steel Tubing

DCW Domestic Cold Water

DCVA Double Check Valve Assembly

DFU Drainage Fixture Unit

DHW Domestic Hot Water

DWV Drain, Waste, and Vent

FHR First Hour Rating

fps Feet per Second

GGI Gravity Grease Interceptor

GPD Gallons per Day

GPH Gallons per Hour

GPM Gallons per Minute

HGI Hydromechanical Grease Interceptor

IAPMO International Association of Plumbing and Mechanical Officials

ICC International Code Council

ID Internal Diameter

IFGC International Fuel Gas Code

IPC International Plumbing Code

LP Liquefied Petroleum (gas)
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Abbreviation Definition

MBH Thousands of BTU per Hour

NOAA National Oceanic and Atmospheric Administration

NFPA National Fire Protection Association

OD Outside Diameter

PDI Plumbing and Drainage Institute

PE Polyethylene

PEX Cross-linked Polyethylene

POU Point of Use

psi Pounds per Square Inch

psia Pounds per Square Inch Absolute

PVB Pressure Vacuum Breaker

PVC Polyvinyl Chloride

RPBA Reduced Pressure Backflow Assembly

SDR Standard Dimension Ratio

SF Square Feet

SVB Spill-Resistant Vacuum Breaker

TDH Total Dynamic Head

TMV Thermostatic Mixing Valve

UPC Uniform Plumbing Code

VFD Variable Frequency Drive

WC Water Closet

WSFU Water Supply Fixture Unit

WH Water Heater

in. WC Inches of Water Column

This guide was generated by the J∆S Engineering Suite v1.2. For additional assistance, access the built-in Help System

from the application menu bar (Help > Interactive Help) or refer to the companion guides in the output/guides/ directory.
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